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Overview of LifeTime
Personal Information Managers
LifeTime is a member of the family of software products called Personal Information Managers("PIM"
for short).    A PIM lets you use your computer to aid you in keeping track of your schedule of daily 
appointments, and your non-scheduled list of "things to do".    Beyond that, PIMs vary in their 
inclusion of additional features - the better PIMs, like LifeTime, will always allow you to: attach 
Alarms, Priorities, or Due Dates to items where appropriate; keep extensive notes attached to your 
schedule or To-Do items; maintain a Phone Book with AutoDial capabilities; Print your Schedule and 
To-Do lists, Notes, and Phone Book information; and Find any given text string wherever it appears 
within the stored information.    

The LifeTime Advantage
Although there are many PIMs on the market, including a large number of Windows PIMs, users are 
often frustrated by the difficulty or awkwardness in using them.    They may have all the features that 
a user needs, but not much thought went into making those features easily accessible.    Some 
people give up on PIMs as a result of this frustration.

Ease of Use
LifeTime was designed from the ground up with ease-of-use as much in mind as quality of features.   
For instance, since the single most important function required of a PIM is to store the individual 
items relating to appointments or things to do, why should it be anything but utter simplicity to enter 
them?    Yet PIM after PIM will make you pull up a separate form to type in your item, then make you 
jump through some more hoops to set a start time and end time for it.    In LifeTime, the main screen 
is always ready to start receiving the next item - you just start typing.    When you hit Enter, the item 
becomes an object that you move with your mouse along a timeline to set the start time; then you 
shape the height of the object with your mouse to set its duration.    This quick and intuitive method 
produces an added bonus - your screen always shows your appointments as time blocks, and the 
blank space shows you exactly where your free time is.

Visual Cues
Another LifeTime innovation is its use of visual cues (color and texture) to convey information.    Why 
should you have to search for a little "A" to the left of    items to find the ones that have an alarm - or 
a little "N" for an attached Note?    If your item in LifeTime has an alarm, it's unmistakeable - its text is
red (by default).    Similarly, an item with an attached note is recognized immediately by its italicised 
font.

Popup Technology
Wouldn't it be nice to be able to quickly see the schedule and To-Do items for any other day while still
keeping today's items in place?    Well, LifeTime has an exclusive "Popup Schedule" that does just 
that when you click on any calendar day with your right mouse button.    A similar "Popup" motif 
allows you to instantly access any of the properties of an item.    Little things, maybe, but it's the little 
things like these that clearly set LifeTime apart.

Animated Tutorial
In the interests of getting you off to a quick start in your use of LifeTime, we have included an 
animated Tutorial which demonstrates some of the features we talked about above.    If you've 
already seen it, we hope you enjoyed it.    If not,    you can access it from the Help menu.





Letter From the Author
Dear LifeTime User,
        The wonderful reception that LifeTime has received since its initial release in July of 1994, has 
proved to me I was right in thinking that there was a market in the crowded Windows PIM world for a 
product that has almost no 'learning curve', but provides all the important information management 
functions most people need.

        When I surveyed the current PIM "scene", not only to see what is available, but what computer 
user's reactions are to what is available, I noticed some interesting things.    First, there is a class of 
what I call "Mega-PIMs", which do everything that's reasonable to expect of a PIM - then they add on
massive additional features that do such things as Project planning, Outlining, or intensive Contact 
management.    These features may be needed by some people, but they may be better served by 
getting a separate package for the specialized feature instead of paying a mega-price for the Mega-
PIM.

        Then there are the products that do stick pretty much to the classic PIM features, which is all the 
vast majority of potential PIM users need.    I consider LifeTime to be in this category - but, with a 
difference.    Many users have reported frustration as they try one PIM after another, only to find them
all awkward to use.    It's true - none of the PIMs out there til now have seemed to operate with the 
intuitive ease and friendliness that the majority of PIM seekers apparently crave.    From this I 
recignized there is a vast, untapped market that LifeTime can fill - the market for a PIM that is not 
only user-friendly, but is actually fun to use!    LifeTime elevates mouse usage to a new height in the 
PIM world.    You can drag-and-drop, drag-and-modify, drag-and-print, drag-and-dial, drag-and-view, 
and mouse-click your way to the Time-management efficiency you always suspected a computer 
could provide. 

        This major upgrade to LifeTime continues the same philosophy that guided the original release.    
Rather than weighing it down with new features, this release makes the existing features even easier
to use, and guided by suggestions from you - the users, some very significant improvements have 
been added:

·  Because YOU wanted a WAV sound file option for the Alarm, it's in there!
· Because YOU wanted an improvement in the 'one page per day' printing functions, the Print has 

been completely rewritten from scratch, and now includes customizable headings, multiple 
formats, and Print Preview!

· Because YOU wanted a 'first Tuesday and third Thursday' type recur option, you now have it!
· Because YOU wanted an Ascii import for Phone data from other products, you now have one!
 I invite you to use and explore this Evaluation copy of Lifetime as my guest for the next few weeks, 
to see what a difference it can make in helping you organize your life, work, and related information.   
This try-out period entails no cost or obligation to you.    It is my hope that you will be impressed 
enough to want to obtain a registration license for your copy, which will come with a professional 
manual and other goodies which are themselves worth the $29.95 registration fee.    If you decide not
to register, I request that you discontinue using the product and remove all copies from your 
computer - this is not free software, and the fact that there is a free evaluation period does not mean 
the use of this product is legal beyond the three-week period without registering it.    As the free 
Evaluation period comes to an end, you will be reminded gently but insistently that the time to 
register is at hand, though the product will continue to operate.    I regret having to include such 
"reminders", and it was bothersome to build them into the product, but the way I look at it is: if I didn't 
include the reminders, I would be placing the temptation in front of good, honest people to start 
putting off their registration until later, with "later" never seeming to arrive.
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          LifeTime's data access is accomplished through VB/ISAM™    from Software Source.      If you 
appreciate the fast data access provided by LifeTime, you can thank their fine product.

          Sincerely,

Stephen B. Uber



Installing LifeTime
The LifeTime install is simple, and does not update any of your Windows system files.

How to Install
1 Put the diskette with the LifeTime program files into your diskette drive.
2 In Program Manager, pick "Run" from the File menu, then type A:\SETUP.EXE as the program to 

run.
3 The Setup program will ask you where to place the program files. It will suggest a directory called

C:\LIFETIME, but you may change that if you wish.
4 The Setup program will then copy all the files into your specified directory and create a LifeTime 

icon within its own program group.
See Also

Network Use



Network Use
Each user of LifeTime on a shared network must have the program files installed on their own hard 
drive. By default, LifeTime stores your items, notes, and phonebook information in datasets located 
on the same drive and directory where you have the program itself.    If space is limited on this drive, 
you may choose to locate this data on another drive, in particular a drive that you can access through
a network that you are connected to.    Another reason for doing this is if you are part of a team or 
workgroup, all of whose members are using LifeTime, or may be in the future.    

You would want to be on a shared database in this situation, because then the database as a whole 
could be administered by the workgroup's leader or someone else given that responsibility.    The 
administrative activities would include group scheduling, that is, discovering what are the time blocks 
when no one on the team has an item scheduled, and optionally creating a new item that would 
appear on everyone's list.    The tool for achieving this is the LifeTime Network Administrator's 
module, which will be made available soon.    All interested registered LifeTime users will be sent an 
offer when this module becomes available.

Installing on a Network
To use LifeTime on a network, each user must perform the normal install to their own hard drives.    
Then each must point to the common network path where the database is to reside.

How To
Install LifeTime
Set a Network Path
Set your Network ID
Set your Active Path



Setting a Network Path
A network path lets you keep your data off your own hard drive, and it can be stored in a common 
location with that of other LifeTime users in your work area.    This allows for group scheduling and 
easier database administration, with LifeTime's optional Network Administrator's module.

Instructions
· Select the "Network Path" option under the "Network Use" pick of the "File" menu.
· Type in the full drive and path information, with this format:
N:\TEAMA\LIFEDATA
· Hit Enter

See Also

Network Use
Setting Your Network ID
Setting Your Active Path



Setting Your Network ID
Your network ID is a unique "key" by which your personal information will be labeled on a shared 
network drive, so it must be different than that of any other user using the same path.    A good choice
for a network ID would be your LAN security ID, but any unique character combination up to 8 
characters will work.

Note: Although you may change your network ID after you establish it, doing so will leave you unable
to revert back to the earlier ID, so data entered under it will be lost to you.

Instructions
· Select the "Network ID" option under the "Network Use" pick of the "File" menu.
· Type in your unique network ID.
· Hit Enter.

See Also

Network Use
Setting a Network Path
Setting Your Active Path



Setting Your Active Path
Once you have established an optional network path, you may make it your "official" path that comes
up automatically when you start up LifeTime.    You may then at any time switch this "official" path 
back to the original database on your own drive that LifeTime established for you when you first ran 
it.

Instructions
· Pick the "Path" option from the "Settings" choice of the "Options" menu.    The Path Window 

appears.
· Select the radio buttons that specify the path setting you want.    Note you may point at a Phone 

Book on your "original" path while pointing to Schedule/ToDo data on the network drive, or vice 
versa.

· Click the "Ok" button, or hit Enter.

See Also

Network Use
Setting a Network Path
Setting Your Network ID



Registering your Copy
Why Register?
Your use of LifeTime is intended to be free for a limited time of 3 weeks, so that you can decide 
whether it suits your needs.    If you intend to use the product beyond this period, you are required to 
pay a fee to Amber Timbre Software for the registration of your copy of LifeTime.    In return, you get 
a Registration Key file, which uniquely identifies your copy and eliminates all registration reminder 
prompts when you run the program.    Registration only costs $29.95 (plus $5.00 for handling), for 
your first copy. If you order more than one copy, each additional copy will cost you only $19.95,.with 
no additional shipping charges.    At no extra charge, you also get the following for each copy you 
order:

· A professionally printed User's guide that serves as the perfect companion to the Help file.    It 
includes screen-print illustrations and 'Power-user' tips so that LifeTime can enhance your 
productivity to the maximum.

· A Database Maintenance utility that allows you to Archive, Backup, or Purge the older data you 
no longer need to refer to all the time. You can Restore it again later if you do need it.    With all 
the important notes and other information you will be putting into LifeTime, you really need this 
utility.    Complete with its own Windows Help file.

· A Report Writer for printing out powerful summaries of your data (for example, a list of all 
completed To-Do items, as the basis of a progress report).    Complete with its own Windows 
Help file.

See Also

How to Register



How to Register
By Credit Card
You can order single copies with MasterCard, Visa, American Express, or Discover from PsL by 
calling 800-242-4775 or 713-524-6394.    These numbers are for ordering only - they wll not provide 
technical support. Questions involving your order status or technical support must be directed to 
Amber Timbre Software.    See "Technical Support" in this Help file.

Through Compuserve
Members of the Compuserve service may register online, FOR SINGLE COPIES ONLY,and will be 
billed by Compuserve.    Just type GO SWREG to get to the registration facility. LifeTime's 
Registration ID is 2855.

Through the Mail
Payment must be in U.S. dollars.    The cost to register one copy of LifeTime is only $29.95 (Plus 
$5.00 shipping and handling).    Total payment of $34.95 may be made by check or Money Order.    If 
you are ordering more than one copy, add only $19.95 for each copy after the first.    Please fill out 
and print the LifeTime order form you will find by clicking the "Order a License" pick under the 
LifeTime main Help menu.    Please send a copy of the order form with your payment to:

Amber Timbre Software
P.O Box 380732
East Hartford, CT 06138-0732
U.S.A.

· Orders from Connecticut only must add state sales tax ($2.10) for a total cost of $37.05.    For 
orders of more than one copy, in Connecticut add $1.20 in state sales tax for each extra copy 
you order.

· Orders from outside the United States may include payment (in U.S. dollars only) in one of the 
following forms: A check drawn from an account in a U.S. bank; an American Express Money 
Order; an International Postal Money Order; or U.S. currency ($35.00).



Technical Support
Amber Timbre Software provides to users of LifeTime, at no charge, assistance in the solving of 
technical problems encountered in the installation or running of the program.    This assistance will 
take place via correspondence through the channels noted below.

CompuServe and America Online
Correspondence will be in the form of private E-Mail to members of either of these services.

· CompuServe Address: 72202,2403
· America Online Address: ATSoft
· Internet Mail Address: atsoft@aol.com

Direct Mail
· Amber Timbre Software

P.O. Box 380732
East Hartford, CT 06138 - 0732



Create a Copy
We would like to see as many people as possible try a Free Evaluation Copy of LifeTime.    To that 
end, we make it easy for you to make a complete copy on a diskette to give to someone who has 
become interested.    Included on the copy will be all files that you received to let you install LifeTime 
on your own machine.    Since we do not want any copies distributed without each of these files, the 
copy will not be performed if any are detected as missing.    Of course, none of the items, notes, 
phone information, or other data that you have entered into your copy of LifeTime will be copied in 
this process.

All that is required to create a copy is a formatted, blank diskette of at least 1.4 Meg capacity (that 
would be a double-sided, high density 3.5" diskette).    All that space is not needed for the copy, but 
the next size capacity down, 750 K, is too small.

Instructions
· Choose the "Create a Copy" pick from the "File" menu.
· Type in the drive letter where you want the copy to go, and hit Enter. Any path information you 

put in will be ignored - the copy will be written to the root directory.
· Insert the diskette into the specified drive.
· The copying of the files will then take place, taking several minutes.
· Let the person receiving the copy know they should execute the SETUP.EXE file on the diskette 

to install LifeTime on their own machine.



License and Disclaimer

This license entitles any user to examine and make personal use of an Evaluation copy of LifeTime 
for a period of 21 days. To continue using LifeTime beyond this 21 day period, a registration fee must
be paid to Amber Timbre Software or its agent.    Use of LifeTime beyond this 21 day period without 
registration is illegal.

Users of a registered or Evaluation copy of LifeTime are free to make copies of it so that other users 
can examine it for the evaluation period of 21 days, as long as such a copy contains all of the files 
that are copied as a result of choosing the "Create a Copy..." pick from the File menu of LifeTime.

Under no circumstances may a copy of the "LIFETIME.KEY" file that is present with a registered 
copy of LifeTime be distributed to any other person.    A registered user may copy the 
"LIFETIME.KEY" file and all other LifeTime files as part of his own personal data backup procedures,
or for his own personal use of LifeTime on different computers.

AMBER TIMBRE SOFTWARE DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, 
WHETHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND ALL 
SUCH WARRANTIES ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED.
 
NEITHER AMBER TIMBRE SOFTWARE NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN 
THE CREATION, PRODUCTION OR DELIVERY OF THIS SOFTWARE SHALL BE LIABLE FOR 
ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF THE USE OR 
INABILITY TO USE SUCH SOFTWARE EVEN IF AMBER TIMBRE SOFTWARE HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS.
 
IN NO EVENT SHALL AMBER TIMBRE SOFTWARE'S LIABILITY FOR ANY DAMAGES EVER 
EXCEED THE PRICE PAID FOR THE LICENSE TO USE THE SOFTWARE, REGARDLESS OF 
THE FORM OF CLAIM. THE PERSON USING THE SOFTWARE BEARS ALL RISKS AS TO THE 
QUALITY AND PERFORMANCE OF THE SOFTWARE.
 
Some states do not allow the exclusion of the limit of liability for consequential or incidental 
damages, so the above limitation may not apply to you.

This agreement shall be governed by the laws of the State of Connecticut and shall inure to the 
benefit of Amber Timbre Software and any successors, administrators, heirs and assigns. Any action 
or proceeding brought by either party against the other arising out of or related to this agreement 
shall be brought only in a STATE or FEDERAL COURT of competent jurisdiction located in Hartford 
County, Connecticut.    The parties hereby consent to in personam jurisdiction of said courts.

By registering your copy of LifeTime, you are agreeing to the terms and conditions of the above 
Amber Timbre Software license agreement.



The Schedule Display
This is where you can look at, edit, or add new Schedule items to any given day. You must be on the 
Full Screen or Items Only presentations of the LifeTime main screen to see this display.

Getting to the Schedule Display from the To-Do Display
· Hit Ctrl + S
                    or

· Click on the "Sched" index tab in the upper right.
                    or

· Double-click on a blank part of the viewport.

Features of the Schedule Display
· If there are items higher than the top edge of the viewport, or lower than the bottom edge, the 

corresponding lights at the ends of the scrollbar will be on.
· You can set the time corresponding to the top edge of the viewport (that is, what will be there on 

program start-up) to be a time of your choosing.    The default time is 7:00 A.M.
· When you are looking at the schedule for today's items, the day-of-the-week heading at the top 

of the screen will have red letters, by default.    Also, there will be a small red Time Indicator at 
the appropriate current time position along the left side of the viewport.

· You can set the AutoScroll feature on so that your displayed Schedule items will slowly move up 
on the screen to keep pace with the passage of time.

· You may vary the Magnification at which the items are displayed.    A higher magnification allows 
for smaller time increments to be used.

· The left and right arrow buttons at the screen's bottom allow you to go backward or forward one 
day in the Schedule display.    Hitting F4 or F3 will also go forward and back a day.

See Also

The ToDo Display
Day Title
Items
Presentation Style
Display Defaults
Zoom



The To-Do Display
This is where you can look at, edit, or add new Schedule items to any given day. You must be on the 
"Full Screen" or "Items Only" presentations of the LifeTime main screen to see this display.

Getting to the To-Do Display from the Schedule Display
· Hit Ctrl + T
                    or

· Click on the "ToDo" index tab in the upper right
                    or

· Double-click on a blank part of the viewport.

Features of the To-Do Display
· If there are items higher than the top edge of the viewport, or lower than the bottom edge, the 

corresponding lights at the ends of the scrollbar will be on.
· When you are looking at the list of today's items, the day-of-the-week heading at the top of the 

screen will have red letters, by default.
· The left and right arrow buttons at the screen's bottom allow you to go backward or forward one 

day in the To-Do display.

See Also

The Schedule Display
Day Title
Items
Presentation Style
Display Defaults
Priority



Day Title
You may assign a title to give a general characterization to any given day.    Examples would be 
"SALES SEMINAR" or "VACATION".    The Day Title displays in the Hold area.

Mouse/Keyboard Method
· Choose the Day Title pick from the "Options Menu"

        or
Double-click on the Hold Area.

· Type in your choice of Day Title, or revise the title that is already there.
· Hit Enter.



Items
An item is an entry in the scrollable viewport of LifeTime's main screen, representing a Schedule 
appointment or a To-Do task.

How to
Create an Item
Change the Text of an Item
Copy an Item
Move an Item
Delete an Item

General item properties
Complete
Notes
Link
Recur
Schedule item properties
Start Time
Duration
Alarm
To-Do item properties
Due Date
Priority



Creating an Item
An item can be entered any time the main LifeTime screen is showing without any sub-screens on 
top of it.    Just type in the text of your item (it will show in the text box above the viewport), and hit 
Enter.

· If the To-Do items are showing, your new item will appear below all the other To-Do items.
· If the Schedule items are showing, the new item will appear in the Hold area.    From here you 

can drag it with the mouse or move it with the keyboard to its proper start time.
See Also

Copying an Item
Moving an Item
Setting the Start Time



Copying an Item
You may make a copy of any item to place on another day, or even to move a copy between the 
Schedule and the To-Do list.    Only the text of an item is copied, not its properties, with the exception 
that the duration of a Schedule item will be included in a copy of one.

Mouse Method
· Choose "Copy" from the Popup Menu.    A copy of the item appears in the Hold area.

          or
Drag the item to the Hold area, making sure to press and hold the Ctrl key before dropping the 
item there.

· Set the day and viewport where you want the copy to go.
· Drag the item from the Hold area to its new location, and drop it.
See Also

Popup Menu
Keyboard Method
· Highlight the item you want to copy.
· While holding down the Ctrl key, hit the Enter key.    The item's copy will appear in the Hold area.
· Set the day and viewport where you want the copy to go.
· Hit the Down-Arrow to highlight the new item.
· While holding down the Alt or Ctrl key, hit the Down-arrow key to bring the new item into the 

viewport.
· Continue hitting Alt or Ctrl and the Down or Up-arrow key to place the item to its correct time.
See Also

Moving an Item



The Popup Menu
This "floating" menu allows you to quickly access the functions and properties associated with any 
individual item.    Its picks correspond exactly to the picks under the "Items" choice of the "Options" 
menu.

Accessing the Popup Menu
The Popup Menu can be accessed only by clicking on an item with the right mouse button.    After it 
appears, you click on one of the choices with the left mouse button.

See Also

The Options Menu
Items



The Options Menu
This contains functions related to the display of LifeTime's main screen, and the manipulation of 
items in the viewport.

Day Title
Allows you to assign an overall title to a day.

Settings
These picks give access to the various default settings, which include: setting the time or date, 
choosing display defaults, defining your print parameters, defining your autodial parameters, setting 
the display of your name in the title bar, and choosing which path to point to for data.

Item
Allows you to set properties for the item you have selected.    These include: an alarm (for Schedule 
items), the Complete property, the due date and priority (To-Do items), a link to a phone entry, access
to an attached note, and item recurrence.    There are also functions to manipulate the item here: 
copy, delete, and move.

Calendar
The Calendar can be advanced forward and backward with the sub-picks to this choice.

Day Displayed
The day of the Schedule/To-Do viewport can be adjusted forward and backward with the picks here.

Presentation
This has picks to control the LifeTime main screen display size: full size, view of the viewport items 
only, or view of the Calendar only.

Zoom
The picks under this choice allow you to adjust the magnification of the Schedule viewport.

Views
Here you can choose to see the Week View or Month View Windows.

Phone Book
This pick brings up the Phone List showing all names in your Phone Book.



Alarms Enabled/Alarms Disabled
You can toggle between activating the all alarms and deactivating them with these picks.

Schedule/To-Do
These control which of the two item lists appears in the viewport.



Moving an Item
An item may be moved either to a different position on the viewport, or it may be moved to a different
day.    It may also be moved between the Schedule and To-Do list. 

How To
Move an Item within its Viewport
Move an Item to a new Day or Viewport



Moving an Item within its Viewport
The effects of a move differ somewhat between a To-Do and a Schedule item. In the Schedule view, 
the item is simply moved to a new time.    For a To-Do, the item will be moved above the item in the 
list it is dropped on.    If you have the To-Do items sorted by Priority, an item cannot be moved outside
of its own Priority group.

Mouse Method
· Drag the item to a new position on the screen, and drop it.
Keyboard method
· Highlight the item you want to move.
· Holding the Alt key down, press the Up or Down-arrow key until the item is at the position on the 

screen where you want to release it.
· Hit Enter.

See Also

Setting the Start Time
Display Defaults



Setting the Start Time
Mouse Method
· Drag the Schedule item in the viewport with the mouse, and drop it when its top edge lines up 

with the desired time increment on the left side of the viewport.    The exact time you are dropping
it on will be displayed on the left side of the Hold area.

· For finer control over the start time you set when dragging with the mouse, use Magnification 4, 
or set Snap-To off.

Keyboard Method
· Highlight the Schedule item.
· Hit the Ctrl + Up or Down arrow key (large increments), or the Alt + Up or Down-arrow key (small 

increments) until the item's top edge lines up with the desired time increment on the left side of 
the viewport.    Then hit Enter.    The exact time you are dropping it on will be displayed on the left
side of the Hold area.

· For finer control over the start time you set with the keyboard, use Magnification 4.

See Also

Display Defaults
Zoom
Snap-To



Display Defaults
These defaults apply to the display of Schedule and To-Do items in the viewport.    This window is 
accessed from the "Display" pick of the "Settings" choice of the "Options" Menu.

· Time and Zoom - Set the time that will be at the top of your Schedule viewport when you start up 
LifeTime every day.    You can also set the magnification, or Zoom level, that will show at start-up.

· Time Display - Choose a 24-hour or 12-hour format.
· Startup Display - You can have either the Schedule items or the To-Do items display first on 

startup.
· Alarm Sound - Set the Duration and Pitch of the Schedule Alarm function.    Alternatively, choose 

a WAV file you would like to use for the alarm sound.    You may choose from any WAV file you 
have stored in your WINDOWS directory.

· AutoScroll - Turn this function on to make your Schedule items automatically scroll up during the 
day.    Hit "A" to toggle this.

· Snap-To - Set this to make schedule items that you drop into the viewport snap exactly to the 
nearest time increment.    Hit "S" to toggle this.

· Priority Sort - With this set on, your To-Do items will always be sorted by highest to lowest 
priority.    Hit "P" to toggle this.

See Also

Snap-To



Snap-To
The Snap-To setting in the Display Defaults window gives you the ability to quickly set the start-time 
and duration of Schedule items to standard default increments, or to gain a greater precision over 
these settings.

Snap-To features
· Snap-To has no effect over keyboard manipulation of schedule items, only over mouse 

manipulation.
· Snap-To controls increments in magnifications 1 and 2, but has no effect in magnification 4.
· With Snap-To on, start-time and duration increments correspond with the visible time lines to the 

left of the Schedule viewport.    This means 30 minute increments in magnification 1, 15 minutes 
in magnification 2.

· With Snap-To off, the start-time and duration can be modified in 5 minute increments in 
magnifications 1 and 2.

How to set Snap-to
· Choose "Options", then "Settings", then "Display" from the LifeTime menu to bring up the Display

defaults window.
· Snap-To may be toggled on or off by clicking on the appropriate choice with the mouse, or by 

hitting "S" in the keyboard.
See Also

Display Defaults
Setting the Start time
Setting the Duration
Relating Magnification to Duration



Setting the Duration

Mouse Method
· Place the mouse cursor inside the borders ot the Schedule item whose duration you want to 

adjust.
· Press down and hold the right mouse button.
· Slowly move the mouse downward or upward while holding the button. The duration will increase

or decrease one increment, depending on the direction of the mouse movement.
· The item's exact duration at any given time will be displayed on the right side of the Hold area.
· Continue until the duration is at the desired length, then release the right mouse button.
· For finer increments of duration adjustment with the mouse, set Snap-To off or use Magnification 

4

Keyboard Method
· Highlight the Schedule item whose duration you want to adjust.
· Hit Alt + "+" key (small increments) or Ctrl + "+" key (large increments) to increase the duration. 

Hit Alt or Ctrl + "+" key to decrease it.
· The item's exact duration at any given time will be displayed on the right side of the Hold area
· Continue until the duration is at the desired length, then Hit Enter.
· For finest control over Schedule item duration, use Magnification 4.
See Also

Zoom
Relating Magnification to Duration
Snap-To



Zoom
This unique feature allows you to vary the apparent size of the items in your Schedule Display.    
When you raise the magnification,    it means that the duration of your appointments can be adjusted 
in smaller increments than the half-hour of Magnification 1.    The start time increments are also 
calibrated in smaller lengths at higher magnifications.    Note, however, that at higher magnifications, 
the viewport displays a smaller portion of the day.

· Vary the Zoom by hitting Ctrl + I or Ctrl + O to Zoom In or Out.

See Also

Relating Magnification to Duration



Relating Magnification to Duration
The magnification you have set on the Schedule viewport will determine the amount of time in each 
increment of duration change.    Here are the increments and defaults that correspond to each 
magnification:

Magnification 4
The amount of each duration increment change is 1 minute.    The Snap-To setting has no effect in 
magnification 4.    The minimum duration for any item is 5 minutes.

Magnification 2
The amount of each duration increment change is 30 minutes with "Snap-To" on, and    5 minutes 
with "Snap-To" off.    In this magnification the duration cannot be set to less than 15 minutes.    If, in a 
higher magnification, an item's duration is set to less that 15 minutes, the item will be represented in 
magnification 2 by a box without a border.

Magnification 1
The amount of each duration increment change is 30 minutes with "Snap-To" on, and 5 minutes with 
"Snap-To" off. In this magnification the duration cannot be set to less than 30 minutes.    If, in a higher
magnification, an item's duration is set to less that 30 minutes, the item will be represented in 
magnification 1 by a box without a border.

See Also

Zoom
Snap-To



Moving an Item to a new Day or Viewport
Moving the item to a new viewport means moving it from the Schedule to the To-Do list or vice-versa.

Mouse Method
· Drag the item to the Hold area, or choose "Move" from the Popup Menu.
· Change to the new day or viewport where you want the item to go.
· Drag the item from the Hold area to its new location.
Keyboard Method
· Highlight the item you want to move.
· While holding down the Ctrl key, hit the Up-arrow key until the item moves into the Hold area.
· Change to the new day or viewport where you want the item to go.
· Hit the Down-Arrow key to highlight the item in the Hold area.
· While holding down the Alt or Ctrl key, hit the Down-arrow key to bring the new item into the 

viewport.
· Continue holding Alt or Ctrl and hitting the Down or Up-arrow key to place the item in the position

where you want it.



Changing the Text of an Item
The text of any item can be revised.

· Highlight the item.
· Edit the item text in the box just above the Hold area.
· Hit Enter.



Deleting an Item
When you delete an item you will also be deleting any note that is attached to it.    The exception to 
this is when you delete a recurring item with an attached note, in which case the note is deleted only 
if you are also deleting all occurrences of the recurring item.

Mouse Method
· Drag the item to the trash can icon in the lower left of the screen.

        or
Choose "Delete" from the Popup Menu.

Keyboard Method
· Highlight the item.
· Hold the Shift key down and hit the Delete key.
See Also

Notes
Recur
Popup Menu



Notes
You can add a note of up to 32,000 characters to any To-Do or Schedule item.    You can also add a 
note that is attached to a particular day, instead of to a particular item.

How To
Access the Notes Window
Edit a Note
Print a Note



Accessing the Notes Window
The context in which you bring up the Notes Window determines what the note will be attached to.

Mouse Method
· For a note that will be attached to a To-Do or Schedule item, double-click on the item to which 

you want to attach the note.
      or
Choose "Note" from the Popup Menu.

· For a note you want to attach to a particular day, click on the "Daily Note" button on the upper 
right, when you have the desired day displayed in the viewport.

Keyboard Method
· For a note that will be attached to a To-Do or Schedule item, Highlight the item.
· Hit Ctrl + N.
· For a note you want to attach to a particular day, hit Alt + D after you have the desired day 

displayed in the viewport.
See Also

Popup Menu



Editing a Note
As soon as a Notes Window comes up, you can begin typing text into it.    Alternatively, you can 
Import a text file into the Notes Window.    You can also Cut/Copy/Paste text into or out of a Note 
Window.    If you wish to undo your editing before you save the note, pick the "Undo" option from the 
"Edit" menu.

To save the note, click on the "Ok" button or select "Save" from the "File" Menu.    After a note is 
created, the text of the item it is attached to becomes displayed in italics.    For a note attached to a 
particular day, the text of the "Daily Note" button appears in italics whenever that day is the currently 
displayed day on the Schedule.

How To
Import a Note File
Change the Notes Window Font



Importing a Note File
You may Import an ASCII text file into a Notes Window.

Mouse/Keyboard Method
· Choose "Import" from the Notes Window "File Menu".
· Choose the desired text file using the dialog box that comes up.
See Also

Printing a Note to a File



Printing a Note to a File
You can output any note as an ASCII text file.    Then you can import it into other applications.

Mouse/Keyboard Method
· With the Note's Window displayed, choose "Print to File" from the File Menu.

      or
Hit Ctrl + F.

· A dialog box will come up where you can specify the name you want this file to have.    You can 
also change the directory and/or drive to which it will be written.



Changing the Notes Window Font
You can use any font available on your system to display the text in a Notes Window.    Once you set 
it for one Notes Window, the same font information will also apply to the display of any other note.    If
you will be printing the note from the Notes Window, it is highly recommended that you use a 
TrueType font.

Mouse/Keyboard Method
· Choose "Fonts" from the "Edit" Menu of the Notes Window.
· In the dialog box that comes up, you can specify the font you want, its size, and other display 

properties.
· The font you choose is not saved unless you save the note or click "Ok" on the Notes Window.



Printing a Note
You can print a note at any time you have its window displayed.    You can also print notes as part of 
the Schedule/To-Do print function.    If you wish, the note's text can go to a file instead of to paper.

Mouse/Keyboard Method
· With the Note's Window displayed, choose "Print" from the "File" pick on the Menu.

      or
Hit Ctrl + P.

How To
Print a Note to a File
Print Daily Items
Control your Print



Printing Daily Items
You may print the Daily items, according to your Print Options in the Print Setup Window, for any 
given day.    You may also print the items for an entire week or an entire month.    And, with Select-
Dial, you can print other blocks of days that don't fit into one of the above choices.

Mouse Method
· Print a Day - Drag any day on the calendar to the Print icon underneath the Calendar, and drop 

it.
· Print a Month - Drag the Month name from the Calendar to the Print icon underneath the 

Calendar, and drop it.

Keyboard Method
· Print a Day - Set the Schedule display to the day you want to print, then choose "This Day" from 

the "Print" pick of the "File" Menu.
· Print a Week - Set the Schedule display to any day (Sunday through Saturday) during the week 

you want to print, and choose "This Week" from the "Print" pick of the "File" Menu.
· Print a Month - Set the Schedule display to any day during the month you want to print, and 

choose "This Month" from the "Print" pick of the "File" Menu.

See Also

Select-Print
Printing a Note
Printing the Phone List
Print Control



Select-Print
Sometimes you will want to print a block of days that does not fall neatly into a week, or you may 
want to print some days that are scattered over a month.    Select-Print allows you to select the days 
you want printed, and then to print them.

Mouse Method
· For a block of contiguous days, drag the first day you want printed to the last day, and drop it.
· For single days, click on the day, but hold the mouse down for a longer period than a true 'click'.   

What you must do, in effect, is to drag-and-drop the day on itself.
· You may unselect a day or range of days by repeating the process above.
· Selected days are identified by a yellow background color.
· All selected days must be in a single calendar month.
· To print the selected days, drag any one of them to the Print icon below the Calendar, and drop 

it.

See Also

Printing Daily Items
Print Control



Print Control
Anytime you invoke the Print function for Schedule, Notes, or Phone information, you are brought to 
the Print Control window.    Here you can set parameters concerning the print formatting, including 
what printer to send it to.

Header
· Type in information that will appear at the top of each printed page.

Font
· Click the Fonts button to get into the Fonts Dialog box.
· You may choose a font name and font size, and whether it is "Regular", "Italic", or "Bold" style.
· It is highly recommended that you use a TrueType font for best results.

Page Size
· Choose the appropriate page size you would like for your prints.    You may choose one of the 

pushbutton pre-defined sizes, or set your own customized page size, in inches or centimeters.

Calendar Print Options
· When printing Calendar data, choose whether to include Schedule, To-Do and Notes data.

Phone Book Print Options
· When printing out of the Phone book, specify how much of the information in each entry you 

want printed.

Preview
· This button allows you to see on-screen what your print will look like before you send it to the 

printer.

Printer
· Set the destination printer with this button.    The name of the chosen printer will appear 

underneath.

See Also:

Printing



Printing
LifeTime allows you to do three types of printing of your stored information.    One is the print of your 
daily Schedule/To-Do items (with their attached notes, if you wish); another is the print of individual 
notes from the Notes Window; the third is the print of your Phone List.

How To
Control a Print
Print Daily Items
Select-Print
Print a Note
Print the Phone List



Printing the Phone List
You may print out the contents of your Phone List from the Phone List Window.

General Information
· You may choose to print out the names and numbers alone, or include the addresses, or also 

include the text in the "Descriptive" and "Log" boxes of the Phone Entries.
· The print's page size, font, and font size will be as specified on the Print Control window.

Producing the Print
· Choose Print from the "File" menu of the Phone List Window.    This brings up the Print Control 

window.
· Choose the radio button for a print with name and numbers only; or name, numbers, and 

addresses; or all Phone Entry information.
· Check the box below the radio buttons if you want to print out only the Phone List entry that is 

currently highlighted.
· Click the "Print" button.    You may preview your print first by clicking the "Preview" button.

See Also

Printing Daily Items
Print Control



Recur
With Recur you may make a Schedule or To-Do item repeat at a regular interval, such as every week
or every month.

How To
Create a Recur
Delete a Recur



Creating a Recur
A Recur starts out as an item like any other.    You can then convert it to a Recur.

Mouse Method
· Choose "Recur" from the Popup Menu of the item you want to turn into a Recur.    The Recur 

Window will appear.
· Select a Frequency from the dropdown list box.    This specifies how often the recurring item will 

repeat.
· Click the date on the Calendar when you want the item to stop recurring.    Or, you can make it 

recur indefinitely into the future by checking the "Continue Indefinitely" radio button.
· If this is a Schedule item, you may set or revise the Alarm by clicking the Set Alarm button.    If a 

To-Do, you may set or revise the Priority by clicking the Set Priority button.

Keyboard Method
· Highlight the item you want to turn into a Recur.    Choose "Items" then "Recur" from the 

"Options" pick of the LifeTime Menu.    The Recur Window will appear.
· Select a Frequency from the dropdown list box.    This specifies how often the recurring item will 

repeat.
· Type in the date when you want the item to stop recurring    Or, you can make it recur indefinitely 

into the future by checking the "Continue Indefinitely" radio button.
· If this is a Schedule item, you may set or revise the Alarm by hitting Alt + A.    If a To-Do, you may

set or revise the Priority by hitting Alt + P.

See Also

Setting an Alarm
Setting or Changing the Priority
Popup Menu



Setting an Alarm
You can set a new alarm on an item, or revise an existing alarm at any time.

Mouse Method
· Choose "Alarm" from the Popup Menu of the Schedule item for which you want to set or revise 

an alarm. The Alarm Window will appear.
· Use the scrollbar to set how long before the appointment you want the alarm to begin sounding.
· Click the "Ok" button.

Keyboard Method
· Highlight the Schedule item whose alarm you want to set or revise.
· Hit Ctrl + A. The Alarm Window will appear.
· Type in the number of minutes (60 or fewer) before the appointment you want the alarm to begin 

sounding.
· Hit Enter.

See Also

Popup Menu



Setting or Changing a Priority

Mouse Method
· Click with the right mouse button on the far left side of the To-Do item whose priority you want to 

set or change.
                    or

· Choose "Priority" from the Popup menu of the item.
· The Priority Window will appear.
· Double-click on the color representing the item's new priority.
                  or

· Single-click on the color and then click on the "Set" button.

Keyboard Method
· Highlight the To-Do item whose priority you want to set or change.
· Hit Ctrl + R.    The Priority Window will appear.
· Hit the letter representing the item's new priority.
· Hit the Enter key.

See Also

Display Defaults
Popup Menu



Deleting a Recur
You may delete all occurrences of a Recur, by deleting any occurrence of it as you would delete any 
other item.    You will be asked to confirm that you wish to delete all occurrences.

See Also

Deleting an Item



Complete
You may mark an item Complete when it is done.    The visual effect of Completing an item is that its 
text changes color.    If the item is a Schedule appointment, and the alarm was set, Completing the 
item will unset the alarm.    If the item is on the To-Do list, Completing it will cause it to remain on that 
day; it will not be carried forward as un-Completed items are.

Mouse Method
· Choose "Complete" from the Popup Menu.

Keyboard Method
· Highlight the item you want to Complete.
· Hit Ctrl + H.

      or
Choose "Item", then "Complete" from the Options Menu

See Also

The Schedule Display
The To-Do Display
Popup Menu
Options Menu



Link
A Link allows you to tie any To-Do or Schedule item to a specific entry in the Phone Book.    It is 
possible to pull up the Phone Entry Window, with that entry displayed, from the item that is linked to 
it.    Once an item has been Linked, its text appears underlined.

How To
Create a Link
Sever a Link
Use a Link



Creating a Link
Mouse Method
· Choose "Link" from the Popup Menu of the item you want to link.    The Phone List Window will 

appear.
· Find the name you want to link to, and click on it.
· Click on the "Select" button on the bottom of the screen.

Keyboard Method
· Hit Ctrl + L.    The Phone List Window will appear.
· Find the name you want to link to, and select it with the space bar.
· Hit Alt + S to complete the link.

See Also

Creating a Link from the Phone Entry
Creating a Link from the Phone List
Popup Menu



Creating a Link from the Phone Entry
From the Phone Entry you can cause a To-Do item to be created which will remind you to contact the
person on one of the entries.    The ToDo item will be linked back to the entry.

Mouse Method
· If you want a particular phone number to be on the linked To-Do item, click on the phone number.
· Click on the box that says "Contact again on" if the light next to it is not already on.
· Click on the date on the Calendar where you want the linked To-Do to be placed.
· Click on the "Ok" button.

Keyboard Method
· If you want a particular phone number to be on the linked To-Do item, tab to it.
· Hit Ctrl + A to toggle the "Contact again on" light on, if it is not already.
· Toggle to the date field and type in the date where you want the linked To-Do placed.
· Hit Alt + O.



Creating a Link from the Phone List
From the Phone List window you can use your mouse to create a Schedule or To-Do item from any 
entry in the list.

Method
· Click on an entry in the Phone List, brining up its associated phone numbers.
· If you want a particular phone number to be on the linked To-Do item, click on the phone number.
· Make sure part of the Hold Area is visible on the main screen, moving the Phone List window if 

necessary.
· Drag-and-drop the name from the list onto the Hold Area.    This creates a new linked item.
· Bring the viewport to the day when you want the reminder, then drag-and-drop the item onto the 

Schedule or To-Do list.



Severing a Link
If the link on an item no longer seems relevant, you can sever it.

Mouse Method
· Choose Link from the Popup Menu of the linked item.    The Phone Entry Window will appear 

showing the linked entry.
· Click on the "UnLink" button.

Keyboard Method
· Highlight the item whose link you want to sever.
· Hit Ctrl + L.    The Phone Entry Window will appear showing the linked entry.
· Hit Alt + L.

See Also

Popup Menu



Using a Link
At the time you need the phone number or other information contained on the Phone Entry, use the 
link to immediately see it.

Mouse Method
· Choose "Link" from the Popup Menu of the item whose link you are using.    The Phone Entry 

with the linked information will appear.
· Click on the Cancel button when you no longer need to view the information.

Keyboard Method
· Highlight the item whose link you want to use.
· Hit Ctrl + L.    The Phone Entry Window will appear showing the linked entry.
· Hit Alt + C when you no longer need to view the information

See Also

Popup Menu



Start Time
The start time for a Schedule item is set when you first place it on the viewport.    It can be changed 
at any time after that.

How To
Set the Start Time



Duration
The duration of a Schedule item corresponds to the height of the box representing it on the viewport.

How To
Set the Duration
Relate Magnification to Duration



Alarm
An alarm may be set on any Schedule item.    Setting an alarm includes setting how long before the 
appointment it should go off.    The alarm will continue to sound until one minute after the 
appointment start time, unless it is turned off.

How To
Set an Alarm
Turn Off an Alarm
Disable/Enable All Alarms

See Also

Display Defaults



Turning Off an Alarm
An alarm may be turned off before it begins sounding, or after it has begun sounding.    After the 
alarm has begun sounding, an Alarm Notification window will pop up indicating that an alarm has 
gone off, and giving its description.    It will ask if you want to turn the alarm off, and will remain visible
until you answer Yes or No. You also have a "Snooze" option for the alarm. The following methods 
can turn off an alarm at any time.

Mouse Method
· Choose "Alarm" from the Popup Menu of the Schedule item whose alarm you want to unset.    

The Alarm Window will appear.
· Click on the "UnSet Alarm" radio button.
· Click on the "Ok" button

Keyboard Method
· Highlight the Schedule item whose alarm you want to unset.
· Hit Ctrl + A.    The Alarm Window will appear.
· Hit Ctrl + U to check the "UnSet Alarm" radio button.
· Hit Enter.

Note
· To stop an alarm when it has begun sounding, you may also hit Ctrl + Alt + A.

"Snooze" Feature
When the Alarm Notification window pops up after an alarm has started to go off, one of the choices 
on the window is "Snooze".    The effect of clicking on this button is to silence the alarm, and reset it 
to go off again at approximately half of its current lead time. When the actual start time of the 
appointment is reached, clicking the "Snooze" button will have no effect.

See Also

Popup Menu



Disable/Enable all Alarms
You can prevent any alarms from going off when their set times are reached.    You can remove this 
setting, and the alarms will go off as scheduled.

Mouse/Keyboard Method
· Choose "Alarms Disabled" from the LifeTime "Options" Menu, to disable all alarms.    The Alarms 

Disabled icon will appear to the right of the Calendar.
· Choose "Alarms Enabled" from the LifeTime "Options" Menu, to re-enable all alarms.    The 

Alarms Disabled icon to the right of the Calendar will disappear.

See Also

Turning off an Alarm



Due Date
You can set a due date for when a To-Do item should be completed.    When a due date is set for an 
item, the far left side of the item will display the number of days left until the due date.

How To
Set a Due Date
UnSet a Due Date



Setting a Due Date

Mouse Method
· Choose "Due Date" from the Popup Menu of the To-Do item on which you want to set a due 

date.
                      or

· Click on the far left side of the item with the left mouse button.
· The Due Date Window appears.
· Click the date on the Calendar that you want to be the due date.
· Click the "Ok" button.

Keyboard Method
· Highlight the To-Do item for which you want to set a due date.
· Hit Ctrl + U to bring up the Due Date Window.
· Type in the date that you want to be the due date.
· Hit Enter.

See Also

Popup Menu



UnSetting a Due Date
You can unset any existing due date on a To-Do item.

Mouse Method
· Choose "Due Date" from the Popup Menu of the To-Do item whose due date you want to 

change.
                    or

· Click on the far-left part of the To-Do item with the left mouse button.
· The Due Date Window appears.
· Click on the "UnSet" button.

Keyboard Method
· Highlight the To-Do item whose due date you want to unset.
· Hit Ctrl + U. The Due Date Window appears.
· Hit Alt + U.

See Also

Popup Menu



Priority
You can assign a color-coded priority to any To-Do item.    If the Priority Sort is turned on, your To-Do 
items will appear in order of their priorities.

How To
Set or Change a Priority

See Also

Display Defaults



Presentation Style
The LifeTime main screen has three different "styles" in which you can display it.

Full-Screen
This is the display presentation that comes up when you start up LifeTime.

· Access the Full Screen Presentation from one of the others by hitting Ctrl + F3, or, if you are in 
the Calendar Presentation view, clicking on any calendar day will bring up that day in the Full 
Screen view.

Items Only
This display truncates off the Calendar from the display, so you in effect see only the viewport, and 
its controls.

· Access the Items Only Presentation from one of the others by hitting Ctrl + F2.

Calendar
This display shows only the Calendar and the icons underneath it.

· Access the Calendar Presentation from one of the others by hitting Ctrl + F1, or, if you are in the 
Full Screen Presentation view, by clicking on the Month Name above the Calendar.



The Calendar

General Information
· Clicking on a day on the calendar with the left mouse button will cause that day's items to be 

displayed in the viewport.
· Any days that have Schedule items on them will appear by default in blue on the Calendar, 

except for the current day, which is always red.
· The Julian day, and the number of days left in the year appear in the lower right of the Calendar 

page.    These numbers are for whatever day is currently displayed in the viewport.
· The coloring of the Month and Year in the Calendar's title indicates whether this Month/Year is in 

the past, the future, or is the current Month/Year.
· The buttons under the Calendar with the single arrow to the left and right will move the Calendar 

forward or back one month.    The day displayed in the viewport is unchanged by this.    The same
results can be obtained by hitting the F6 and F5 keys.

· The buttons under the Calendar with the double arrows to the left and right will move the 
Calendar forward or back one year.    The day displayed in the viewport is unchanged by this.    
The same results can be obtained by hitting the F8 and F7 keys.

· The button under the Calendar with today's date will return both the calendar and the viewport to 
the current day/month/year.    Hitting F12 will do the same thing.

How To
Select a date on the Calendar

See Also

Printing
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Week View
Month View



Selecting a Date on the Calendar
You can go to any day displayed on the Calendar, and view or edit the items for that day.    You can 
also select a day from the Calendar whenever you need to set a date field on a sub-form (Mouse 
Method only).

Mouse Method
· Get to the desired month on the Calendar by clicking on the arrow buttons underneath it.
· Click on the desired day with the left mouse button.

Keyboard Method
· Get to the desired month on the Calendar by hitting F5 for the previous month, or F6 for the next.

Also, F7 changes the Calendar to the previous year, and F8 the next.
· While holding down the Ctrl key, type in the number of the desired day in the displayed month.

See Also

Popup Schedule



The Popup Schedule
The Popup Schedule allows you to see a list of the Schedule and To-Do items for any day, in a 
popup window.    The advantage of the Popup Schedule is that you can view these other days' items 
without having to change the day that is displayed in the viewport.

Mouse Method
· Click on any day on the Calendar with the right mouse button.
                    or

· Click on any day on the Month View with the right mouse button.
                    or

· Click on any day on the Week View with the right mouse button.
· Click anywhere on the screen to make the Popup Schedule disappear.

Keyboard Method
· While holding down the Alt key, type in the number of the day in the currently-displayed Calendar

month whose Popup Schedule you want to see.
· Press any key to make the Popup Schedule disappear.

See Also

Month View
Week View



Month View
From the LifeTime main screen, you can at any time see the schedule/To-Do list for any month, 
independent of what day is displayed in the viewport.

Mouse Method
· Drag and drop the month name from above the Calendar to the Month View icon below and to 

the right of the Calendar.    The Month View for that month appears.
· Clicking on any day in the Month View, to select it, allows you to page up and down in that day's 

schedule.
· Double-clicking on any day in the Month View causes the LifeTime main screen viewport to 

display that day's items.
· Clicking with the right mouse button on any day in the Month View brings up the Popup Schedule

for that day.
· Clicking on the buttons on the bottom with left and right arrows shifts the Month View forward or 

back one month.

Keyboard Method
· To see the Month View for the month currently displayed on the Calendar, hit Ctrl + M.
· You may tab to any day in the month, and page up or down in its schedule.
· Hitting Alt + F and Alt + B takes you forward a month or backward a month, respectively.

See Also

The Popup Schedule



Week View
From the LifeTime main screen, you can at any time see the schedule/To-Do list for any week, 
independent of what day is displayed in the viewport.

Mouse Method
· Drag and drop the day from which you want the Week View to begin, to the Week View icon 

below and to the left of the Calendar.    The Week View for that week appears.
· Clicking on any day in the Week View, to select it, allows you to page up and down in that day's 

schedule.
· Double-clicking on any day in the Week View causes the LifeTime main screen viewport to 

display that day's items.
· Clicking with the right mouse button on any day in the Week View brings up the Popup Schedule 

for that day.
· Clicking on the buttons on the bottom with left and right arrows shifts the Week View forward or 

back one week.

Keyboard Method
· To see the Week View for the week starting with the currently displayed day, hit Ctrl + W.
· You may tab to any day in the week, and page up or down in its schedule.
· Hitting Alt + F and Alt + B takes you forward a month or backward a month, respectively.

See Also

The Popup Schedule



The Phone Book
You can store names, addresses, phone numbers, and contact information in the Phone Book.    It 
has sophisticated Autodial capabilities, and you can    create a linked To-Do item from within a phone 
entry.

Phone Book Features
The Phone List
The Phone Entry
AutoDial
Printing the Phone List



The Phone List
This Window lists, in alphabetical order, all the entries in your phone book.    You can use the Autodial
feature from this screen, or move on to the Phone Entry Window for one of the items on the Phone 
List to see the detailed information about that person.

To get to the Phone List, click on the "Phone Book" button or hit Alt + D.

How To
Browse a Phone List Member
Select a Phone List Member
Add a Phone List Member
Delete a Phone LIst Member
Create a Link from the Phone List
AutoDial from the Phone List
Print the Phone LIst



Browsing a Phone list Member
From the Phone List Window, you can see the phone numbers and the company for any member.

Mouse Method
· Use the scrollbar until you see the name you want.
· Single-Click on the name.

Keyboard Method
· Use the yellow text box to type in the first part of the last name you want, so the list box will scroll

to that name.
· Tab to the list box and use the arrow keys to get to the name you want.

See Also

Selecting a Phone List Member



Selecting a Phone List Member
You can select a Phone List member to get to the detailed Phone Entry Window for that member.

Mouse Method
· Double-click on the member you want detailed information on.    The Phone Entry Window for 

that member will appear.

Keyboard Method
· When you are browsing the name you want detailed information on, hit Alt + S to select it and 

bring up the Phone Entry Window for that member.

See Also

Browsing a Phone List Member
Phone Entry



The Phone Entry
This is where you can enter and view all the detailed information about the people on your phone list.

Phone Entry Features
· You may enter up to four telephone numbers for an entry.    The descriptive labels to the left of 

the numbers are all editable.
· Each entry contains a Descriptive note area, for you to keep information you want to remember 

about this person, and a Log area, for you to record notes about your contacts with him.
· LifeTime's exclusive Select-Dial lets you choose what part of the phone number to dial.
· The Access window lets you integrate the use of carrier access and credit card numbers with 

your Autodialing.
· You can set a date for when to next contact this person, and a linked To-Do item reminding you 

about it will be automatically created for that date.

How To
Create a Phone Entry
Clone a Phone Entry
Delete a Phone Entry
Move Through the Phone Entries
AutoDial from the Phone Entry
Select-Dial
Create a Link from the Phone Entry



Creating a Phone Entry

Mouse/Keyboard Method
· To create a new phone entry, you come to the Phone Entry Window from the Phone List Window.

Click on the "New" button, or hit Alt + "N" while on the Phone List.
· Fill out the fields you need to on the Phone Entry Window.
· Click "Ok" or hit Alt + O to return to the Phone List.    Or, if you want to enter another new entry, 

click on the "Clone" or "New" button, or hit Alt + C or Alt + N.

See Also

Cloning a Phone Entry



Cloning a Phone Entry
When you clone a phone entry, you are adding a new name to the phone book, but instead of 
starting out with all blank screen fields to fill in, all the information from the entry you are cloning from
is still on the screen, except the Name fields and the Title.

Mouse/Keyboard Method
· Make the Phone Entry Window display the entry you want to clone, either through browsing 

through the Phone Entries, or choosing a member on the Phone List.
· Click on the "Clone" button, or hit Alt + L.
· Fill in the Name fields, and the Title field.    You may also change any of the the prefilled 

information.
· Click on the "Ok" button or hit Alt + O.

See Also

The Phone List
Selecting a Phone List Member.
Creating a Phone Entry.
Moving Through the Phone Entries



Moving Through    the Phone Entries
While in the Phone Entry Window, you may move to the next entry in alphabetical order, or to the 
previous one.

Mouse/Keyboard Method
· To move forward in alphabetical order, click the 'Right arrow' button on the bottom, or hit Alt + F.
· To move backward in alphabetical order, click the 'Left arrow' button on the bottom, or hit Alt + B.

See Also

Selecting a Phone List Member



Deleting a Phone Entry
You may delete any entry from the Phone Entry Window.      All information is deleted for the entry.    
The name is also removed from the Phone List Window display.

Mouse/Keyboard Method
· Get the entry you want to delete to display on the Phone Entry screen.
· Click on the "Delete" button or hit Alt + D.

See Also

Moving Through the Phone Entries
Selecting a Phone List Member



AutoDialing from the Phone Entry
If you have a modem on your computer, you may autodial any number on a Phone Entry.    You must 
first have set up the autodial parameters in the AutoDial Setup Window.    If your phone usage 
requires dialing a long-distance prefix or suffix, or a credit card number, use the "Access" menu pick.

Using the Prefix
· Under the label "Dial Prefix?", click on the word "Yes" if you want to use the Prefix, or on "No" if 

you do not.
· Hit Ctrl + P    to toggle between "Yes" and "No".
· If you click "Yes" you may edit the prefix in its text box.    Choosing "Yes" means the prefix will be 

dialed before the number you choose for autodial.

AutoDialing
· Drag the phone number you want to the Phone icon underneath the list of phone numbers, and 

drop it there.
                    or

· Tab to the phone number you want to use, and hit Alt + I.

See Also

AutoDial
Select-Dial
AutoDial Setup
Long-Distance Access



AutoDial
Autodial allows you to dial any phone number you have stored in LifeTime's Phone Book, if you have
a modem attached to your computer.

AutoDial Features
· You specify the COM port your modem is attached to, and other information, in the AutoDial 

Setup Window.    This must be filled out before you can use AutoDial.
· The Prefix is something you would use if your company has a code that is dialed to get an 

outside line.    It can be filled in on the AutoDial Setup Window, but you can choose whether to 
use it, and even change it, at the time you are autodialing from one of the Phone Windows.

· Long-distance access codes and credit card numbers can be integrated with normal Autodialing.

See Also

AutoDial Setup
Select-Dial
AutoDialing From the Phone List
AutoDialing from the Phone Entry
Long-Distance Access



AutoDial Setup
The parameters on this window are for controlling the functioning of the AutoDial feature of the 
Phone Book.    The Window is accessed by choosing "AutoDial" from the "Settings" pick of the 
"Options" Menu.

· Dialing Prefix - This number will be dialed in front of any number in your Phone Book that you 
AutoDial.

· Port - You must specify which of the COM ports your modem is connected to.
· Select-Dial - Turn this dialing aid on or off.
· Dial Type - Specify if your phone uses Tone or Pulse Dialing.

See Also

Select-Dial



Select-Dial
Select-Dial is a unique feature that you can use from the Phone Entry Window or the Phone List 
Window.    It allows you to "select off" a part of the phone number that you do not want to dial when 
you use autodial.

Why you might need Select-Dial
You will want to store any long-distance number with (1-) and its area code.    But when you travel to 
that location,    and the number converts to a local call, you will not want to dial the long-distance 
information.    With the Select-Dial option turned on, you can autodial only the local part of the 
number.

Mouse Method
· Be sure Select-Dial is turned on in the AutoDial Setup Window.
· When you are ready to drag the phone number for the autodial, place the cursor at the end of the

long-distance information, and press the left mouse button.
· Drag the cursor straight to the left, moving outside the left edge of the phone number's box, still 

holding down the left mouse button.    All the long-distance information will be "selected", and you
will be in the act of dragging the rest of the phone number.

· Continue dragging the phone number down to the Phone icon.    The number displaying just 
above the Phone icon shows the portion of your phone number that will actually be dialed.

· Drop the phone number on the Phone icon.

Keyboard Method
· Be sure Select-Dial is turned on in the AutoDial Setup Window
· Tab to the phone number you want to autodial.
· Hit Shift + Right-arrow until you have selected the portion of the number you don't want to dial. 

The number displaying just above the Phone icon shows the portion of your phone number that 
will actually be dialed.

· Hit Alt + I to dial.

See Also

AutoDial Setup
AutoDial
AutoDialing from the Phone Entry
AutoDialing from the Phone List



AutoDialing From the Phone List
If you have a modem on your computer, you may autodial any number in the Phone List.    You must 
first have set up the autodial parameters in the AutoDial Setup Window.    If your phone usage 
requires dialing a long-distance prefix or suffix, or a credit card number, use the "Access" menu pick.

Using the Prefix
· Under the label "Dial Prefix?", click on the word "Yes" if you want to use the Prefix, or on "No" if 

you do not.
                    or

· Hit Ctrl + P    to toggle between "Yes" and "No".
· If you click "Yes" you may edit the prefix in its text box.    Choosing "Yes" means the prefix will be 

dialed before the number you choose for autodial.

AutoDialing
· Drag the phone number you want to the Phone icon underneath the list of phone numbers, and 

drop it there.
                    or

· Tab to the phone number you want to use, and hit Alt + I.

See Also

AutoDial
Select-Dial
AutoDial Setup
Long-Distance Access



Long-Distance Access
You may need to access a long-distance service, or use a credit card or calling card number when 
you dial.    To integrate this into your Autodialing, choose "Access" from the Phone List or Phone 
Entry menu, to bring up the Long-distance Access window.

Using Long-Distance Access
· Type in any number you might need to access your long-distance carrier in the "Carrier Access 

Number" box.
· Place your credit card or Calling card number in the "Card number" field.
· A third "Freeform" field lets you put in any additional numbers you may need to dial.
· To integrate these access numbers with your normal Autodialing, click on the "Dial" button next to

the number at the time you need them dialed.    Typically, you would dial the "Carrier Access 
number", then drag-and-drop the phone number of the person you want to call, then dial the 
"Card number".

See Also

AutoDialing from the Phone Entry
AutoDialing from the Phone List



Adding a Phone List Member
You add a new Phone List member by bringing up the Phone Entry Window with blank fields for you 
to fill in.

Mouse Method
· Click on the "New" button.    An empty Phone Entry Window comes up.
· Create your new entry and click "Ok".

Keyboard Method
· Hit Alt + N.      An empty Phone Entry Window comes up.
· Create your new entry and hit Alt + O.

See Also

Phone Entry



Deleting a Phone List Member
You may delete any member in the Phone List.    All information, including all detailed Phone Entry 
information, is deleted for the member.

Mouse Method
· Click on the member in the list box that you want to delete.
· Click on the "Delete" button.

Keyboard Method
· Browse the list entry you want to delete.
· Hit Alt + D.

See Also

Browsing a Phone List Member



The Ascii Import
If you have Phonebook data in another product, and you want to include that data in LifeTime's 
phonebook, the Ascii Import allows you to do that, if the product that contains your phone data can 
export it as a comma-delimited Ascii file.

Import File Format
The file that you import into LifeTime must have an initial record that has the field names 
corresponding to the data fields on the records that follow. Each field name on the initial record must 
be enclosed in double quotes, and there must be a comma between each to separate them. Each of 
the corresponding pieces of data on the records that follow the initial record must also be in double 
quotes, and be separated by commas.
 
Here is an example of how the first few records on such a file might look; in an actual file, the records
would continue on off the page to the right. There can be no wrapping to the next line for any record, 
no matter how long it is:

"Last Name","First Name","Mid. Init.","Company",[etc.]...
"Alby","William","G","Tourney Discount Sports",[etc.]...
"Anderson","Julia","","IDI Inc.",[etc.]...
Notice how, in the third record, the person has no middle initial, but there is still a double-quote with 
no space in between, sitting in the position where the middle initial would be.    This is because every 
field named on the initial record must have a corresponding data field on each of the records that 
follow, even if it is just represented by the double-quote with no space in between. Notice also that 
the commas separating the fields in all records sit directly after one double-quote and directly before 
the other, with no spaces separating them.

Importing the Data
· Choose "Ascii File Import" from LifeTime's File menu.
· On the Ascii Import window, click on the File menu and choose "Import File", and specify the 

import filename in the dialog box that comes up.
· The field names on the first record of the import file will appear in the list box on the left.    Fields 

describing LifeTime's phone data fields will be in the list box on the right.
· Click on the first entry in the left-hand list box. Then click on any field in the LifeTime list box on 

the right, that you want to match up the import field with. Notice you can choose 'Do not Match 
Field' in the LifeTime box, if the import field does not seem to correspond with any LifeTime 
phone data field.

· Repeat this process for EACH and EVERY field in the Import fields box. Each must be matched 
up with something in the LifeTime box.    As you pick each match, it is confirmed and appears in 
the list box at the bottom of the window.

· You can match more than one Import field with the same LifeTime field.    This will probably 
happen for the fields you match into LifeTime's 'Home Address' and 'Business Address' fields, 
which might be broken into 'Street', 'City', 'State', 'Zip', etc. in the Import file.    Just remember that
the fields will be put together in LifeTime in the same order they appear on the incoming data 
record.

· Before doing the actual import, check through the list box on the bottom to make sure every field 
is matched up right.    If not, cancel out of the window and start again from scratch.

· Click on the 'Process Import File' button, and the phone records will be added to LifeTime's 
phone database.

Data Touch-Up



If you matched multiple fields into the LifeTime Home and Business Address fields, each of those 
fields will come out separated by several spaces in the address box displayed within LifeTime's 
Phone Entry window.    After the automatic word-wrap within the Address box display, you may want 
to change where the line breaks occur in the address. This can be accomplished with a simple touch-
up that must be done from within LifeTime's Phone Entry window.

· Get the first record you want to touch-up into the Phone Entry window.
· Click with your mouse directly in front of any word that you want to begin on the next line down, 

so the cursor is sitting in front of that word, with no space separating them.
· Hit the Enter key on the keyboard.    This inserts an invisible New Line character that causes 

everything following it in the address to move down to the next line.



Doing Finds
Using the Find Window, you can search for any text string in the information you have placed into 
LifeTime.    You may search through all the information, or limit the search to certain categories.    
After a search is done, you may narrow the results further by searching for a second text string only 
within the items that matched on the prior search.    This process may be repeated as many times as 
you like.

Mouse/Keyboard    Method
· Pick "Find" from the "Options" Menu.    The Find Window appears.
· Type in the text you want to find.    Do not surround it with quotes, or they will be searched for, 

too.    And, the search does not distinguish between capital letters and small letters.
· Choose the Categories where you want to look for the text string.
· Choose the "Find" button.    The list box will show what items contained the text string, if any.
· To do a sub-search on these items, type in the new text string, and check the "Prior Search" 

category.
· To see one of the items that satisfied the search, double-click on it.
                    or

· Highlight the list item you want, and choose the "Select" button.



Preference Settings
You can customize many of the Display, Print, AutoDial, and other functions.    Your settings are then 
saved permanently until you change them again.

Setting Time and Date
Display Defaults
Print Setup
AutoDial Setup
Setting Your Name
Setting Colors



Setting Time and Date
You may change or reset the time or date on your computer's clock.

Mouse/Keyboard Method
· Choose "Date/Time" from the "Settings" pick of the "Options" Menu.
· Type in a new time to set the computer to, or use the radio buttons to adjust for Daylight Savings 

or Standard time.
· Click on a calendar day to set a new date.
                    or

· Type in a valid date
· Hit Enter to have the changes take effect.





Setting Your Name
Your name can display as part of the title bar.    After you add it, it can be revised at any time.    Get to 
this window by choosing "Your Name" from the "Settings" choice of the "Options" Menu.



Setting Colors
LifeTime allows the user to adjust many of the display colors on the main screen.

How to set Colors
· Pick "Options"/"Settings"/"Colors" from the LifeTime main screen menu.
· Drag any color from the bottom of the Set Colors window to any representation of one of the 

display parts.    You will see the result of the color change displayed.
· Repeat with as many color changes as you like
· Click on the "Return to Defaults" button to return to the original LifeTime default colors.
· Click "Ok" when your color adjusting is done.
· Stop the program and start it again to see your new colors fully implemented.



Menus
All major LifeTime functions can be accessed through its menu system, and in some cases the menu
is the only way to access a function.

The LifeTime Main Menu
The Popup Menu
The Notes Window Menu
The Phone List Menu
The Phone Entry Menu



The LifeTime Main Menu

File Menu
Edit Menu
Options Menu
Window Menu
Help Menu



File Menu
This menu has picks related to File and Print related functions.

Create a Copy
This allows you to make a free evaluation copy of LifeTime to give to someone else.

Ascii Phone Data Import
You can import Phone data from another product if it can be put in comma-delimited Ascii form.

Database Manager
This allows you to Backup, Archive, Restore, and Purge your Schedule, ToDo, and Phone 
information.    Available only after registration.

Report Writer
For printing or exporting summaries of Schedule or ToDo items in a specified date range.    Available 
only after registration.

Registration Key Install
Once you register your copy of LifeTime, you will receive a Registration Key diskette that will provide 
a registration stamp to it. After registration, this pick no longer appears in the File menu.

Network Use
This allows you to specify a path and personal ID if you want to store your data on a network drive.

Set Default Printer
Since LifeTime uses your default Windows printer for all of its printing, you can use this pick to easily 
change between printers that may be available to you.

Print
This pick allows you to perform Daily Item print functions.    Its sub-picks allow you to print a given 
day, week, month, or days you have selected.

Exit
This ends the current execution of LifeTime and closes all files.



The Edit Menu
This menu has Cut/Copy/Paste functions to use in editing item text.

Cut
Brings selected text to the Windows Clipboard, and deletes the selected text from its source.

Copy
Brings selected text to the Windows Clipboard, and leaves the selected text as is.

Paste
Copies whatever text is in the Clipboard to a target item at the place of the caret.

Find
Allows you to search all of LifeTime's data or only that in certain categories, for any text string.



The Window Menu
This menu indicates whether the Phone List or Phone Entry Windows are loaded, but hidden.    
Choosing the name of one of them brings it to the foreground.



The Help Menu
This menu allows you to choose between various informational topics, and allows you to print out a 
LifeTime registration order form.

Contents
This brings you to the Contents screen of the Help file you are looking at now.

Search for Help on...
Lets you type in a subject to look for in the Help index.

How to use Help
For those unfamiliar with using Windows Help files.

About...
After you have registered your copy of LifeTime, this pick brings up a window which displays your 
registration stamp information.

Tutorial
Alows you to view an animated tutorial which gives you an introduction to some of LifeTime's 
functions.

Registration Info
Displays a window with information on the cost and benefits of registering your copy of LifeTime.

Order Form
This brings up an online order form for your LifeTime registration, which you can print.



The Notes Window Menu
This menu lets you perform functions on the text of an attached note or Daily Note.

File
The picks under this choice let you do the following: Import a text file into your note, Print the note to 
paper, Print the note to a text file, Save the note contents, and Exit the note Window.

Edit
From the Edit choice you can do Windows Cut/Copy/Paste functions, and a Select All pick lets you 
do a copy or cut of the entire contents of the note.    The Undo pick lets you erase editing changes 
since you last saved the note.    You may also adjust the font used to display the note in the Notes 
Window, and in a print of it from the Notes Window.

See Also

Notes



The Phone List Menu

File
This has a pick that lets you print the contents of the Phone Book, and an Exit pick for closing the 
Phone List Window.

Access
For Long-distance prefix, suffix, or card number dialing, integrated with the normal AutoDial.

Dial
This pick performs the AutoDial function for the selected telephone number.    It has no sub-picks 
beneath it.

See Also

Printing the Phone List
AutoDialing from the Phone List



The Phone Entry Menu

Access
For Long-distance prefix, suffix, or card number dialing, integrated with the normal AutoDial.

Dial
This pick performs the AutoDial function for the selected telephone number.    It has no sub-picks 
beneath it.



Hot Keys
The following is a functional reference to all of LifeTime's hot keys.    Not displayed in the lists are the 
Alt key combinations that correspond to the pushbuttons on the screen that have an underline 
indicating their Alt combination key.

Main Screen Hot Keys
Notes Window Hot Keys
Phone List Hot Keys
Phone Entry Hot Keys
Display Defaults Window Hot Keys



Main Screen Hot Keys

Cut - Ctrl + X

Copy - Ctrl + C

Paste - Ctrl + V

Shift Calendar to Next Month - F6

Shift Calendar to Previous Month - F5

Shift Calendar to Next Year - F8

Shift Calendar to Previous Year - F7

Shift Viewport to Next Day - F4

Shift Viewport to Previous Day - F3

Return Viewport to Today - F12

Pick Calendar Day for Viewport - Ctrl + "number of day in month"

Pick Calendar Day for Popup Schedule - Alt + "number of day in month"

Calendar Only Presentation - F1

Items Only Presentation - F2

Full Screen Presentation - F3

Shift Viewport to Schedule - Ctrl + S

Shift Viewport to To-Do - Ctrl + T

Scroll Down in Viewport - PgDn

Scroll Up in Viewport - PgUp

Week View - Ctrl + W

Month View - Ctrl + M

Zoom In - Ctrl + I

Zoom Out - Ctrl + O



High-light Item - Up or Down arrow

Move Highlighted Item (small increment) - Alt + Up or Down arrow

Move Highlighted Item large increment) - Ctrlt + Up or Down arrow

Increase Highlighted Item's Duration - Alt + "+"    or Ctrl + "+"

Decrease Highlighted Item's Duration - Alt + "-"    or Ctrl + "-"

Delete HighLighted Item - Alt + Delete

Set/Unset Alarm on Highlighted item - Ctrl + A

Silence a Sounding Alarm - Ctrl + Alt + A

Bring up Find Window - Ctrl + F



Notes Window Hot Keys

Cut - Ctrl + X

Copy - Ctrl + C

Paste - Ctrl + V

Print Note to Paper - Ctrl + P

Print Note to File - Ctrl + F

Save Note - Ctrl + S



Phone List Hot Keys

Dial Prefix toggle Yes/No - Ctrl + P



Phone Entry Hot Keys

Cut - Ctrl + X

Copy - Ctrl + C

Paste - Ctrl + V

Dial Prefix toggle Yes/No - Ctrl + P

Linked To-Do Create toggle Yes/No - Ctrl + A

Go Forward to Next Phone Entry - Ctrl + F

Go Back to Previous Phone Entry - Ctrl + B



Display Defaults Window Hot Keys

AutoScroll toggle Yes/No - "A"

Snap-To toggle Yes/No - "S"

Priority Sort toggle Yes/No - "P"



ASCII text file
A plain text file with no font attributes.



caret
A blinking vertical line which indicates an insertion point in an editable text field.



Cut/Copy/Paste
Editing functions provided by Windows through its Clipboard.    For information on using Cut, Copy, or 
Paste, see the Windows User's Guide.



dialog box
Used by Windows to request information about a task you are performing or to supply information you 
might need.    Instructions on using dialog boxes are in the Windows User Guide.



Drag
You can drag a draggable object by putting the mouse cursor on it, then pressing and holding the left 
mouse button.    As you move the mouse, a graphic representation of the object moves with it.



drag
You can drag a draggable object by putting the mouse cursor on it, then pressing and holding the left 
mouse button.    As you move the mouse, a graphic representation of the object moves with it.



drop
A drop of an object occurs when the mouse button that was held down to drag the object is released.



font
A typeface for the screen and/or the printer.    Font sizes indicate the height of a character.    Windows 
TrueType fonts look exactly the same on the screen as they do printed.



Highlight
To highlight an item with the mouse, click on it with the left mouse button.    To highlight an item with the 
keyboard, hit the Up or Down arrow key to cycle through the items until the one you want is highlighted.



Hold area
The dark grey strip just above the viewport.    Items are staged here while being moved to another day.    
Schedule items also appear here when they are created.



Julian day
This indicates how many days there are from December 31 of the previous year, to the currently 
selected date.



registration license
This license will convey on you the right to unlimited personal use of LifeTime on your computer.



shareware
Software, distributed through particular marketing channels, that allows the user to try the program out 
before deciding on whether to pay for registering it.



VB/ISAM™
Copyright © Software Source 1991, 1992; all rights reserved.    VB/ISAM software may not be used, 
copied, modified, transferred, or distributed except as expressly provided in its software license. Only 
licensees of VB/ISAM may create software that uses any part of VB/ISAM.    Software Source, Fremont, 
California, USA; telephone (510)623-7854.



viewport
Displays the Schedule or To-Do items for a given day.    When Schedule items are displayed, the 
viewport has a default color of light blue. When To-Do items are displayed, it is light green.






